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1. Overview 
 
Revo Uninstaller Pro helps you to uninstall software and remove unwanted programs 
installed on your computer even if you have problems uninstalling and cannot uninstall 
them from "Windows Add or Remove Programs" control panel applet. 
 
Revo Uninstaller Pro is a much faster and more powerful alternative to "Windows Add or 
Remove Programs" applet! 
 
With its advanced and fast algorithm, Revo Uninstaller Pro analyzes an application's data 
before uninstall and scans after you uninstall an application. After the program's regular 
uninstaller runs, you can remove additional unnecessary files, folders and registry keys 
that are usually left over on your computer. Even if you have a broken installation, Revo 
Uninstaller Pro scans for an application's data on your hard disk drives and in the Windows 
registry and shows all found files, folders and registry keys so you can delete them. 
 
There are tens of thousands of applications that leave a lot of unused data such as registry 
entries, files and folders in your computer. Not all registry keys left in your computer are 
errors, and the third party registry cleaners cannot detect them. Leftover registry keys in 
combination with leftover files make the registry cleaner's job impossible. Revo Uninstaller 
Pro helps you to remove the leftover registry keys, files and folders after uninstalling an 
application. 
 
With its unique "Hunter mode", Revo Uninstaller Pro offers you some simple, easy to use, 
but effective and powerful methods for uninstalling software. You can use it to manage 
your installed and/or running software programs. 
 

Revo Uninstaller Pro has a very powerful feature called Forced Uninstall.  This feature 
allows you to remove leftovers of programs that are already uninstalled, incomplete 
installations and uninstallations of programs! It does not matter if the program, you want 
to remove, is not listed in Revo Uninstaller Pro or in Windows Add/Remove Programs 
Control Panel applet. Forced Uninstall gives the power to the user but still keeps the safety 
and the accuracy of the results. 
 
Revo Uninstaller Pro has another feature that allows monitoring of installation of a 
program and detects system changes during that installation. The process is done in real 
time – simultaneously! This feature is also very powerful because by monitoring system 
changes during the installation we eliminate all the scanning algorithms when we need to 
uninstall that program. 
 



Revo Uninstaller Pro has a multi level backup system. Backup Manager is the main part of 
that system. It helps you to manage backup information stored by Revo Uninstaller Pro 
after deletion registry entries, files and folders. The other levels of the backup system are  

- Creating system restore point before each uninstall 
- Full Registry backup before each uninstall 
- Full Registry backup once each day Revo Uninstaller Pro is stared 

 
Revo Uninstaller Pro gives you another 8 handy and powerful tools to clean up your 
system. 
 
Here is the list of the tools and utilities included in Revo Uninstaller Pro: 
 
Auto Start Manager - Stop programs that start automatically on Windows startup; speed up 
loading of Windows! 
 
Windows Tools Manager - Handy and useful tools bundled with every version of Windows; 
easily find useful system tools and options! 
 
Junk Files Cleaner - Find and remove unnecessary files from your computer; free up disk 
space and delete files you do not need! 
 
Browsers History Cleaner - Erase web browser history, visited pages history and 
temporary internet files of Internet Explorer, Netscape and Opera web browsers; free up a 
lot of disk space by deleting temporary internet files like temporary saved videos, 
temporary flash files, temporary pictures etc! 
 
Office History Cleaner - Remove the history of most recently used files in MS Office; remove 
your tracks by deleting the list of last opened MS Office documents! 
 
Windows History Cleaner - Remove the history of recently opened files, delete temporary 
files, remove usage tracks and other history items that are saved by Windows; remove your 
tracks saved by Windows for a lot of operations! 
 
Unrecoverable Delete Tool - Erase files and folders forever; be sure that nobody could 
recover your files and folders after deleting! 
 
Evidence Remover - Make sure already deleted files, folders and other data are 
unrecoverable; securely erase your data! 

 



 

2. User Interface 
 

 
 
Main window of Revo Uninstaller Pro is divided on few movable and flexible user interface 
components. By default on the top of the window is the “Menu Bar” it can be turned on/off 
from the “View” menu and it can be moved by dragging it, pressing the mouse button over a 
place different that a menu item.  
 
Beneath the menu bar the main toolbar is located. It consists of some main features of Revo 
Uninstaller Pro and the available commands for the current active tool. Main toolbar can be 
turned on/off from the “View” menu and it can be moved by dragging it, pressing the 
mouse button over part of the toolbar different than a button.  Description text could be 
turned on and off from the options. Also the size of the icons could be changed from the 
options. 
 



On the left side of the main window is the “Tools” toolbar. It consists of the tools included 
in Revo Uninstaller Pro. The same rules valid for the Main Toolbar are valid here too.  
 
On the bottom of the main window is the “Status Bar”. Depending on the active tool it can 
show some additional information. It can be turned on/off from the “View” menu.  
 
Above the “Status Bar” is the “Description Panel”. It shows some common information 
about the active tool. It can be turned on/off from the “View” menu and it can be moved by 
dragging it - pressing the mouse button anywhere in its window. Also the “Description 
Panel” supports an “auto hide” feature that hides the panel showing just one tight line with 
its title. When the mouse is over the title the panel is shown again, when the mouse is 
moved away it gets hidden again. To activate/deactivate the “auto hide” press the small 
button with the shape of a pin in the right upper part of the panel window. 
 
In the middle part of the main window are shown opened tools. There could be a lot of 
opened tools at a time, but only one of them is active. To navigate among the tools just 
press their tab in the top part over the window of the active tool. You can also activate 
already opened tool by pressing its button on the Tools toolbar. 



 
 

3. Uninstaller 
3.1. All Programs 

 
When Revo Uninstaller Pro is started, its main window fills with the programs installed on 
your computer. Depending on your options, other items such as system updates or system 
components may also be listed. Depending on the view option, programs are shown as 
Icons, List, and with Details such as Name, Size, Version, Installation Date, Company, 
Comment, Uninstall String, Registry Key and Website.  
 

 
 
In Details view you can right-mouse click on the column header and show or hide some of 
the columns. This way you can also choose what to print. Printing works only in Details 
view and that is why it is better to setup printing as Landscape view – to see much more 
info in one page.  



 
 
By default Revo Uninstaller Pro shows you programs in Icons view in two groups: 
 New programs – programs installed last 7 days – number of the days could be 
changed from the options, or since last run of the uninstaller; 
 Other Programs – all programs that are installed before last 7 days; 
 
You can separate each program in a group by using the context menu, shown on right-
mouse click on a program. Removing a program from a group is also done from the context 
menu. Default groups are Internet, Games, Multimedia and Utilities. Additional groups 
can be added from the options.  
 
Using the Search field in the upper part of the main window you can filter the list of the 
programs by name. On the right of the “Search” field is the number of found programs that 
match the search criteria. 
 



Revo Uninstaller Pro has an option to export installed programs to HTML, TXT and XLS 
(Excel table). Note that to export installed programs to an Excel you have to have Microsoft 
Excel installed and working properly. You can choose which details you can export. 
 

 
 

Some other commands are available from the context menu:  
Search at Google for – Use it to search with Google for the application name or the 

producer or source of the application. This command will open your default web browser 
and display the results of the search. 

Open About Link – This command will open your default web browser and display 
the address containing information about the application. 

Open Help Link – This command will open your default web browser and display 
the address containing help information. 

Open Update Link – This command will open your default web browser and 
display the address providing update information. 

Install Location – Opens Windows Explorer so you can see where the selected 
application is installed. 

Open Registry Key – Opens the registry editor (RegEdit.exe) and displays the 
registry key containing the uninstall information about the selected application. 
 
The main command you can use on the list of installed programs is Uninstall! Selecting a 
program and pressing Uninstall toolbar button will show up the Uninstall Wizard. 
First Revo Uninstaller Pro will create a system restore point and a full registry backup (if 
this is not disabled in Options) and then Revo Uninstaller Pro will run the built-in 
uninstaller of the uninstalled program. After you have finished uninstallation with it, you 
have to press Scan button to continue the uninstall process with Revo Uninstaller Pro. Note 
that the built-in uninstaller may show up behind other open windows and you many need 
to switch between windows by using Alt+Tab keyboard keys – press and hold Alt key and 
then press Tab. 
 
You can choose scanning mode before scan: 



Safe - performs additional scans in the Registry and on the hard drive to find 
leftover items that are safe to delete. This is the fastest mode. 

Moderate - includes the Safe mode and performs an extended scan to find all of the 
application's leftover information in the most common places of the Registry and on the 
hard drive  

Advanced - includes the Moderate mode and performs a deep and thorough scan to 
find all of the application's leftover information in the Registry and on the hard drive. This 
is the slowest mode. 

 

 
 

Pressing Scan button will trigger scanning for leftovers and the results (if any) will show 
up automatically. Revo Uninstaller Pro first shows you found leftover registry items. 
Registry keys and values found as created by the uninstalled program are bold! Not bold 
keys are considered as not created by the uninstalled program. You can also check mark 
them but they will not be deleted! They have check mark options just because it is easier to 
select the top parent and automatically its sub items are check marked – no need to go 
through all sub items and check mark them separately. So, whatever you check mark, when 
you press Delete button check marked bold items only are going to be deleted, even when 
Select All button is used.  
 



 
 
Deleted registry items are backed up, so if you need them you can restore them from 
Backup Manager! 
 
Revo Uninstaller has advanced algorithms to find leftovers related only to the uninstalled 
program. In some cases these algorithms, especially Advanced uninstall mode, could list 
some items related to another program. It could happen, but NOT necessarily (not always), 
when you have installed two or more versions of a program, for example Adobe Photoshop 
CS and Adobe Photoshop CS4. In this case Revo Uninstaller gives the chance to the user to 
distinguish the leftovers. It also could happen if you want to uninstall only a component of a 
big software package (i.e. a component of Microsoft Office). In that case Revo Uninstaller 
could list the rest of the components as leftovers, because they are installed in the same 
folder and Revo Uninstaller could not distinguish them (Excel, PowerPoint, Word etc). It is 
better Revo Uninstaller to be used to remove the whole package instead of a component.  It 
also has safety algorithms and will NOT list some leftovers if it decides that deleting these 
leftovers will harm your system. So, it does a better job than Windows Add or Remove 
Programs applet and the built-in uninstaller of the application you want to uninstall, but 
still may miss something due to safety and the uninstall mode you choose - Advanced, 
Moderate, Safe. 
 



In Revo Uninstaller Pro we have implemented a lot of protections to make it more safe and 
secure, trying to increase its accuracy in searching for leftovers to the maximum, but of 
course keeping the system and other programs safe.  
 
Basically you can easily distinguish the leftovers (by name, by install path) and in most of 
the cases Select All button could be safely used! There are GUIDs and CLIDS (alphanumeric 
items) which are correct leftovers in 98% of the cases so you can delete them! 
 
Note that Revo Uninstaller Pro creates full registry backup and backs up every item you 
delete! 
 
There is also a context menu which you can see by right-mouse clicking on the leftover 
items. 
 Expand All – expands all items of the shown registry tree – by default it is expanded 
so you may not see any difference first time you use this command 
 Collapse All – collapses all items of the shown registry tree  
 Expand selected key – expands only the selected key and its sub items 
 Collapse selected key – collapses selected key and its sub items 
 Uninstall selected key – deletes the key from the system 
 Mark selected key as Created – marks selected key as created by the program you 
are uninstalling. This feature is useful when you see a registry key which you are sure is 
created by the program, but not marked as created because of the safety algorithms in Revo 
Uninstaller Pro. 
 Add to Exclude List – adds the selected key to exclude lists, which protects the key 
from deletion. Excluded keys have red color and you can edit Exclude List in Revo 
Uninstaller Pro’s options. 
 Open Registry Key… - open selected registry key in Windows Registry Editor 
(regedit)  
 
After finishing registry leftovers removal you can press Next button and continue with the 
file and folder leftovers. Note that Next button may not be available if there are no other 
leftovers found! 
 



 
 
Revo Uninstaller Pro shows you found leftover files and folder so you can check the results 
and delete them. Deleted files and folders are moved to the Recycle Bin by default, so you 
can recover them from there. You can change that from Options -> All Programs. You can 
also see how many leftover files and folders are found. There is a context menu, which you 
can use by right mouse-click on a file of folder. 
 Open – command on the context menu which acts the same way if you double click 
on a file or folder in Windows Explorer. Note that if there is no file association for the file 
you click on then nothing will happen. 
 Properties – command on the context menu, which acts the same way if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification etc. 
 
You can use Select All button to select all found leftover files and folders at once and then 
use Delete button to delete them. 
 



 

3.2. Traced Programs 
 
Traced Programs module of the uninstaller shows all logs of installations traced using 
Revo Uninstaller Pro.  
 
To trace a program with Revo Uninstaller Pro you can right-mouse click on its installation 
(setup) package file or press Install Programs button on the main toolbar.  
 
Using the Search field in the upper part of the main window you can filter the logs by 
name. On the right of the Search field is the number of found logs that match the search 
criteria. 
 
For every log there is information about the name, size of the traced program and date of 
creation of the log. All logs are grouped in two default groups – New Programs and Other 
Programs. Total number of logs is shown in the status bar. 
 
Settings of the module are located in the sub item Traced Programs under Uninstaller 
item in the Options window. 
 
Available commands to work with the logs are: 
 

3.2.1. Uninstall 
Uninstall of a logged program reverts all changes made to the system during the 

install of the program as they are logged by Revo Uninstaller Pro. This process involves 
changes to the Registry, file and folders.  

After the command is executed, uninstall of Registry items, files and folders starts 
and you can see the progress of the process. The window closes automatically when it 
completes. By default all changed Registry items are backed up. If you want to back up the 
uninstall of files and folders then you have to set the option in “Options->Uninstaller” 
 

3.2.2. Custom Uninstall 
Custom uninstall of logged program let you to uninstall only a piece or the all 

changes made to the system during the install of the program. After the command is 
executed, you see the uninstall wizard with one or two steps depending on the items that 
the log consist of. If there are Registry items in the log you will see the first step of the 
wizard - tree with Registry items that you can uninstall. The window is separated on two 
parts – left one is the tree of Registry keys, on the right is the list of values. In the lower part 
of the window there are two counters that show the numbers of values and keys of the 
program that are logged.  
When you click on a key in the tree if it has logged values they are shown in the list. The 
font property of items is used to give more information about the items. Such information 
is: 



Bold item – logged by Revo Uninstaller Pro as created by the installed program 
Red item – the item is excluded from the process of uninstall (the list of excluded 

items is shown in the “Options->Uninstaller->Traced Programs->Registry tab”) 
Grayed item – the item does not exist in the system 

 
You have to check mark items that you want to uninstall. If you want to uninstall all of them 
you can use the “Select All” button to check mark them all.  
 
To start the uninstall operation press “Uninstall” button and you will see the progress of 
the operation.  
 
There are some commands available from the context menu of the tree: 

Expand All – expands the whole tree so the whole hierarchy of keys gets visible 
Collapse All – collapses the whole tree making the only visible item – “My 

Computer”  
Expand selected key – expands only the current key making all its sub items visible 
Collapse selected key – collapses only the current key making its sub items 

invisible 
 Uninstall selected key – uninstalls selected key. The command is executed no 

matter if the key is check marked or not 
Mark selected key as Created – marks the selected key as if it is created by the 

program so it will be removed during the process of uninstall.  
 
Warning: Be very careful using this command! Mark the key only if you are sure that 
it belongs to the logged program but because by one reason or another is not logged 
by Revo Uninstaller Pro 
 

Add to Exclude List – Adds the full path of the current Registry key to the exclude 
list thus protecting it from manipulations during the uninstall 

Open Registry Key – Opens current key in the Windows Registry Editor 
  
There are two commands available from the context menu of the list of values: 

Uninstall selected values – uninstalls selected values. To select more than one 
value you can use left mouse button pressed and press Ctrl key from the keyboard to select 
random values or Shift key to select group of values 

Open Parent Registry key – opens the key owner of selected value in the Windows 
Registry Editor 
 
If there are files and folders in the log you can press the Next button of the wizard and you 
will see the list of logged files and folders. In the lower part of the window there are two 
counters that show the numbers of files and folders of the program that are logged by Revo 
Uninstaller Pro. Also there is an option to rename the items that had been existed before 
the install of the program and during the install it has renamed them. This option is: 
Execute Rename operations of previously existing on the system files and folders. 
 



If you want to uninstall some files and folders you  have to check mark some existing file or 
folders or use “Select All” button to check all existing items and then uninstall  them 
pressing “Uninstall” button 
 
There are two commands available from the context menu of the list of file and folders: 

Open – command on the context menu which acts the same way if you double click 
on a file or folder in Windows Explorer. Note that if there is no file association for the file 
you click on then nothing will happen. 
 Properties – command on the context menu, which acts the same way if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification etc. 
 
Other commands to work with the logs are: 

Delete Log - deletes the log from the list and all data in the log, but the logged 
program is untouched  

Change Icon - change the icon of the log, browsing for an icon from dll or exe file  
Add to Group - add selected log(s) to a existing group (you can manage groups from 

Options->Uninstaller->Groups tab) 
Remove from Group - removes selected log(s) from its current group. 

 

3.2.3. Advanced Uninstall 
 

 
 
While the uninstall of a log is proceeding Revo Uninstaller Pro may recognize  that  there is 
some data that may be related to the uninstalled program, but was not deleted because it 
was not logged by Revo Uninstaller Pro during the installation of the program. In such case 
you will see a window with Advanced Uninstall button. The Advanced Uninstall feature 
let you to review and delete such program’s data that Revo Uninstaller Pro thinks to be 
related to the program you are trying to uninstall. If you want to review and eventually 
delete it press the "Advanced Uninstall" button. That action will start the Advanced 
Uninstall wizard, which may consist of two steps. First one shows possibly related to the 
uninstalled program, keys and values existing in the Registry and the second one possible 
related files and folders on your hard drive(s). 
 
Warning: before deleting data using “Advanced Uninstall” feature, be sure that it is 
related to the uninstalled program or it is created by that program 
 



If there are possibly related to the uninstalled program Registry items you will see the first 
step of the wizard - tree with Registry items that you can uninstall. When you click on a key 
in the tree if it has values they are shown in the list. The font property of items is used to 
give more information about the items. Such information is: 

Bold item – treated by Revo Uninstaller Pro as related to the uninstalled program 
Red item – the item is excluded from the process of uninstall (the list of excluded 

items is shown in the “Options->Uninstaller->Traced Programs->Registry tab”) 
 
You have to check mark items that you want to uninstall. If you want to uninstall all of them 
you can use the “Select All” button to check mark them all.  
 
To start the uninstall operation press “Uninstall” button and you will see the progress of 
the operation.  
 
There are some commands available from the context menu of the tree: 

Expand All – expands the whole tree so the whole hierarchy of keys gets visible 
Collapse All – collapses the whole tree making the only visible item – “My 

Computer”  
Expand selected key – expands only the current key making all its sub items visible 
Collapse selected key – collapses only the current key making its sub items 

invisible 
 Uninstall selected key – uninstalls selected key. The command is executed no 

matter if the key is check marked or not 
Mark selected key as Created – marks the selected key as if it is created by the 

program so it will be removed during the process of uninstall.  
 
Warning: Be very careful using this command! Mark the key only if you are sure that 
it belongs to the logged program but because by one reason or another is not logged 
by Revo Uninstaller Pro 
 

Add to Exclude List – Adds the full path of the current Registry key to the exclude 
list thus protecting it from manipulations during the uninstall 

Open Registry Key – Opens current key in the Windows Registry Editor 
  
There are two commands available from the context menu of the list of values: 

Uninstall selected values – uninstalls selected values. To select more than one 
value you can use left mouse button pressed and press Ctrl key from the keyboard to select 
random values or Shift key to select group of values 

Open Parent Registry key – opens the key owner of selected value in the Windows 
Registry Editor 
 
Possibly related files and folders on your hard drive(s) you can press the Next button of the 
wizard and you will see the list of files and folders. In the lower part of the window there 
are two counters that show the numbers of shown files and folders. If you want to uninstall 
some files and folders you  have to check mark some existing file or folders or use “Select 
All” button to check all existing items and then uninstall  them pressing “Uninstall” button 



 
There are two commands available from the context menu of the list of file and folders: 

Open – command on the context menu which acts the same way if you double click 
on a file or folder in Windows Explorer. Note that if there is no file association for the file 
you click on then nothing will happen. 
 Properties – command on the context menu, which acts the same way if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification etc. 
 
 

3.3. Forced Uninstall 
 
Revo Uninstaller Pro has a very powerful feature called Forced Uninstall.  This feature 
allows you to remove leftovers of programs that are already uninstalled, incomplete 
installations and uninstall remnants of programs! It does not matter if the program, you 
want to remove, is not listed in Revo Uninstaller Pro or in Windows Add/Remove Programs 
Control Panel applet. Forced Uninstall gives power to the user but still keeps the safety and 
the accuracy of the results. 
 
Forced Uninstall requires two parameters to get the job done. At least one of these two 
parameters should be supplied! First parameter is the full path to the program you want to 
uninstall or full path to its install location – to its main folder. You can manually enter the 
path but you can also use the Browse button.   

 
Using the Browse button to locate the program’s executable file (exe) is 

recommended! 
 

You can enter the full path to the install location of an already uninstalled and not existing 
program!  

 
You must enter the exact name of the program you want to remove, because the name you 
entered is searched on your system for, so if you enter a wrong name you will get wrong 
results! For example if you want to remove Microsoft Office 2007 you have to enter 
Microsoft Office Enterprise 2007, and not: Office, MS Office, Microsoft! 
 

 



 
 
Pressing Next button on Forced Uninstall window will trigger Revo Uninstaller Pro to 
search for a built-in uninstaller of the program you want to uninstall. If there is a built-in 
uninstaller, or several possible uninstallers are found, Revo Uninstaller Pro will list them in 
the same Window, so you can choose to run found one or not. Uncheck mark Run selected 
built-in uninstaller if you do not want to run the built-in uninstaller. 
When Run selected built-in uninstaller is unchecked pressing Next button shows you 
another window where Revo Uninstaller Pro first creates a system restore point and full 
registry backup (if that options is not disabled in Options -> Uninstaller), and then starts 
scanning for leftovers. 
 

 



If you want to run the found built-in uninstaller before scanning for leftovers just select it 
and press Next button. A new window containing 3 steps will show up 
 

 
 

Revo Uninstaller Pro will run the built-in uninstaller and after you finish uninstallation 
with it, you have to press Scan button to continue the uninstall process with Revo 
Uninstaller Pro. Note that the built-in uninstaller may show up behind other open windows 
and you many need to switch between windows by using Alt+Tab keyboard keys – press 
and hold Alt key and then press Tab. 
 
Pressing Scan will trigger scanning for leftovers and the results (if any) will show up 
automatically. Revo Uninstaller Pro first shows you found leftover registry items. Registry 
keys and values found as created by the uninstalled program are bold! Not bold keys are 
considered as not created by the uninstalled program. You can also check mark them but 
they will not be deleted! They have check mark options just because it is easier to select the 
top parent and automatically its sub items are check marked – no need to go through all 
sub items and check mark them separately. So, whatever you check mark, when you press 
Delete button check marked bold items only are going to be deleted, even when Select All 
button is used.  
 
Deleted registry items are backed up, so if you need them later you can restore them from 
Backup Manager! 
 
There is also a context menu which you can see by right-mouse clicking on the leftover 
items. 
 Expand All – expands all items of the shown registry tree – by default it is expanded 
so you may not see any difference first time you use this command 



 Collapse All – collapses all items of the shown registry tree  
 Expand selected key – expands only the selected key and its sub items 
 Collapse selected key – collapses selected key and its sub items 
 Uninstall selected key – deletes the key from the system 
 Mark selected key as Created – marks selected key as created by the program you 
are uninstalling. This feature is useful when you see a registry key which for sure is created 
by the program, but not marked as created because of the safety algorithms in Revo 
Uninstaller Pro. 
 Add to Exclude List – adds the selected key to exclude lists, which protects the key 
from deletion. Excluded keys have red color and you can edit Exclude List in Revo 
Uninstaller Pro’s options. 
 Open Registry Key… - open selected registry key in Windows Registry Editor 
(regedit)  
 
After finishing registry leftovers removal you can press Next button and continue with the 
file and folder leftovers. Note that Next button may not be available if there are no other 
leftovers found! 
 

 
 
Revo Uninstaller Pro shows you found leftover files and folder so you can check the results 
and delete them. Deleted files and folders are moved to the Recycle Bin by default, so you 
can recover them from there. You can also change that from Options -> All Programs. You 
can also see how many leftover files and folders are found. There is also a context menu, 
which you can use by right mouse-click on a file of folder. 



 Open – command on the context menu which acts the same way if you double click 
on a file or folder in Windows Explorer. Note that if there is no file association for the file 
you click on then nothing will happen. 
 Properties – command on the context menu, which acts the same way if you right-
mouse click on a file and choose Properties – shows properties like file size, attributes, 
date of creation, modification etc. 
 
You can use Select All button to select all found leftover files and folders at once and then 
use Delete button to delete them. 
 
 

3.4. Install Programs 
 
Revo Uninstaller Pro has a feature that allows monitoring of installation of a program and 
detects system changes during that installation. The process is done in real time – 
simultaneously!  
 
This feature is very powerful because by monitoring system changes during the 
installation, we eliminate all the scanning algorithms when we need to uninstall that 
program and nevertheless we can still use these algorithms but in another feature called 
Forced Uninstall.  
 

 
 

 
 
Scanning algorithms are very good on detecting leftovers but Revo Uninstaller Pro has also 
safety algorithms that are blocking listing of some leftovers because of the system safety. 
With this feature we monitor system changes and we are sure that the changes are made by 
the installed program.  
 
There is a big restriction for using that feature - you cannot install two or more programs at 
the same time or run/start other programs during the installation! You can run/start one 
setup file, which can install many programs but you cannot run many setup files! 
 
IMPORTANT! Please, do NOT run/start any other setup files, programs or anything 
else, which could lead to system changes, during the installation of a program! 
 
Basically, you can do all that but the log file, which is created after installation will contain 
also the changes made by other setup files and/or programs. You can use Custom 
Uninstall mode on Traced Programs, which allows you to mark and uninstall the things 
you want. So, even if you by mistake start another program or setup you can still remove 
only the program you uninstall! 
 



This feature has one more big advantage – because it works in real time it does not require 
additional time for installation of a program. It is very easy to use and requires only few 
steps to get maximum results. 
 
To install programs through Revo Uninstaller Pro you have two options: 

- Use the Install Programs toolbar button of the uninstaller or Install Programs 
command from the Commands menu of the uninstaller. Browse for the setup 
file of the program you want to monitor and follow the instructions of the 
installation wizard of the program you are installing – as usual. 

Or there is another option: 
- Right-mouse click on the setup file of the program you want to install and choose 

Install with Revo Uninstaller Pro command. Then follow the instructions of 
the install wizard as usual. 

 
When installation process is started through Revo Uninstaller Pro a toolbar like band will 
be shown at the top of your screen. The installation process will continue in the usual way 
and Revo Uninstaller Pro will monitor system changes during the installation.  You can 
change that band with a little toolbar from 

Options -> Trace programs in compact mode 
 
When you finish installing the program we advise you to run it (if there are several 
components run them all) and configure it. This way Revo Uninstaller Pro will log the 
configuration settings and when you uninstall that program it will remove also these 
settings.  
 
After running the program you have to press Stop button on the Revo Uninstaller Pro’s 
band. Then Revo Uninstaller Pro will suggest you a name for the log. That name will be 
listed in Traced Programs tab in the uninstaller. You can change the name if it is not so 
accurate suggestion and then press Save button. 
 
Here is the summary you have to do to install programs with Revo Uninstaller Pro: 
 

1. Right-mouse click on the setup file of the program you want to install (or 
use Install Programs toolbar button in Revo Uninstaller Pro) 

2. Install the program as usual 
3. Start and configure the program (programs) 
4. Press Stop and Save on the band (toolbar) 

 
Some programs require restarting before you able to run them for the first time. If that is 
the case you have to Stop monitoring, Save the log and then restart. Revo Uninstaller Pro 
has the ability to detect system restarts and save the log automatically, but in this case the 
name of the log will be the name set by Revo Uninstaller Pro.  



 

3.5. Hunter Mode   
 

Hunter mode is an innovative and flexible feature of Revo Uninstaller Pro, which 
gives you ability with one click to uninstall, stop or delete only by aiming 
applications icon on the desktop, quick launch toolbar, system tray or opened 

application. This can be very useful because a lot of applications are loading on start up and 
stay in the system tray without your agreement or you don’t even know which that 
application there is. 
 
When you press “Hunter mode” button on the main toolbar of Revo Uninstaller Pro current 
window will disappear and a small blue target window will appear at the right upper 
corner of your screen. Hunter mode is now activated. 
 
There are some main options in Hunter mode, which are available on its context menu 
(right-mouse click): 

Open main window – open Revo Uninstaller Pro’s main window and exits Hunter 
mode 

Auto Start with Windows – sets Hunter Mode to start automatically on Windows 
startup 

Window's size – there are three available size of current window – Small, Middle 
and Large 

Transparency - sets the Hunter Mode window’s transparency – 50% by default  
Help – opens current help page 
EXIT – exit Revo Uninstaller Pro 

 
To operate in Hunter mode you have to do the following steps: 
 
1. Press the left mouse button over the blue target window and hold it pressed 
2. Move the mouse over an item supported by Hunter mode (desktop shortcut, open 
window, icon etc.), while doing this, a tool tip is shown with information about the 
application you will select if you release the button 
3. Release the left mouse button and a menu will show up 
4. Select desired command from that menu: 
 

Uninstall – start the Forced Uninstall module of Revo Uninstaller Pro 
Stop Auto Starting – disable the application from auto start when Windows starts 
Kill – Stop the application 
Kill and Delete – stop and delete the application  
Open Containing Folder - Open a new instance of windows explorer and explore 
the directory, where the application is located 
Search at Google for - Use it to search with Google for the application name, file 

name or the company name - producer of selected application. This command will open 
your default web browser and load the result of current search in the Google web site 

Properties - Show application's executable file's properties 

 



 Cancel – Cancel the operation 
 
 
 
 

4. Backup Manager 
 
Backup Manager helps you to manage backup information stored by Revo Uninstaller Pro 
after deletion of registry entries, files and folders if the appropriate options are set. 
Restoring a local restore point, you can restore the whole deleted data, or you can just pick 
and restore a single or few items that you need back. If you need more free space you can 
delete a random local restore point or all stored by Revo Uninstaller Pro local restore 
points. 
 

 
 
Restore points of deleted by Revo Uninstaller Pro information are done when you delete 
data using the “Uninstaller” (in “All Programs” mode or “Traced Programs” mode) or 
“AutoRun Manager” tool. 
By default the option “Options->Uninstaller->Back up deleted Registry items” is turned on 
and Revo Uninstaller Pro backed up deleted Registry data. Also by default deleted files and 



folders are not backed up by the Backup Manager. They are deleted to the Recycle Bin, if 
you want to backup them you have to switch the option “Options->Uninstaller->Delete files 
and folders” to “to Backup folder” 
 
Main window of the Backup Manager shows you all local restore points created by Revo 
Uninstaller Pro. By default they are grouped by date of creation and sorted by hour of 
creation. There are some properties for every restore point in the list as: name of the 
operation, size of the backup point, number of items etc. 
 
Available commands are: 
Restore – After the command is executed the restore of Registry items, files and folders 
starts and you can see the progress of the process. When it completes the window closes 
automatically. 
Custom Restore - After the command is executed, you see the restore wizard with one or 
two steps depending on the items you can restore. If there are Registry items in the backup 
you will see a tree with Registry items that you can restore. You have to set check marks for 
items you want to restore or if you want to restore all of them you can use the Select All 
button to check mark them all. To start the restore operation press Restore button and you 
see a window showing you the progress of restoration. If there are files and folders in the 
backup you can press the Next button of the wizard and you will see the tree of files and 
folders that can be restored. Again you have to set check marks or use Select All button to 
mark items and then restore them pressing Restore button 
Delete - If you execute the command the restore point will be removed from the list and 
the information that it consist of will be deleted to the Recycle Bin. If you want to free up 
the space allocated by that restore point you will have to empty your Recycle Bin after the 
deletion. 
Delete All - This command is available only from main menu Commands. If you execute 
the command all restore points and information that they store still be removed, the list 
will be emptied. All the information is deleted to the Recycle Bin, so to free up used by the 
restore points space you will have to empty the Recycle Bin. 
 
 
 

5. Tools 
 
Revo Uninstaller Pro gives you 8 handy and powerful tools to clean up your system. You 
can access the tools by a toolbar, which is shown by default or by Tools menu. If no Tools 
menu and no toolbar are shown you have to right-mouse click on the status bar (bottom of 
Revo Uninstaller Pro’s main window) and check mark Menu Bar option, and then you will 
see Tools menu. 



 

5.1. AutoRun Manager 
 
Auto Run Manager allows you to manage auto running programs on Windows startup. With 
this tool you can not only enable or disable applications from auto starting on Windows 
startup but also you can get more information about a particular application which is set to 
run when Windows starts. You can get information about the publisher of the auto starting 
program, its description, its launch path - where it is saved on your computer or the status 
of the application - if it's running or not. If this information is not enough to decide whether 
to enable or disable the program from auto starting, you can get more information about 
the publisher and the executable file name directly from Google with just one right-mouse 
click. 
 
When you buy a brand new computer it has no or few applications which are loaded at 
Windows startup. During the time when you install new applications to your PC some of 
these applications are installed as auto starting on Windows startup. You can see some of 
them in the "system tray" (near the clock) as small icons. Often such applications are 
messengers, adware, advertisement programs and applications you do not need to start 
automatically. 
 

 



 
When an application is started it takes resources such as RAM, CPU time. The amount of 
these resources depends on started applications but no matter how much memory and 
resources it takes when the number of started applications is bigger the slower is your 
computer. 
 
If you want a program to start automatically when Windows starts, a common place to put 
the program is in the Startup folder of the Start Menu.  
 
Some applications as anti-virus, firewalls and system programs must be started on 
Windows startup to keep your system running smoothly and without problems. Get 
information for an auto running program as much as possible and decide to enable or 
disable it. 
 
The most common task you would like to do is to disable/enable an application from auto 
starting when the Windows operation system is started. This can be done with a single 
click; all you have to do is to uncheck/check the check box in front of the application. 
 
You can right-mouse click on the column header and show or hide some of the columns. 
This way you can also choose what to print.  
 
There are several commands you can use in AutoRun Manager: 
Run - You can run an application, which status is “NOT RUNNING” just by selecting the 
application in the list of applications and press “Run” button on the toolbar.  
 
Kill - You can stop an application, which status is “RUNNING” just by selecting the 
application in the list of applications and press “Kill” button on the toolbar 
 
Remove - If you want to remove an application from the list and prevent its auto loading 
when Windows is starting then you have to select the application and press “Remove” 
button from the toolbar. Note that it is better to uncheck mark it only, because in that way 
it will be removed from startup but will remain in the list of AutoRun Manager so you can 
check mark it again if you need it in future.  
 
Add – You can add programs to start automatically on Windows startup. 
 Name – Enter the name of the program and that name will appear in AutoRun 
Manager 
 Command (full path) – full path to the program you want to run automatically. You 
can also add parameters, but if you do so add quotes to the path i.e.: 
“C:\Program Files\VS Revo Group\Revo Uninstaller Pro\revounin.exe” /hunter 
  
Set auto start for: 
 All users – if you want that program to start on every user login 
 Current user – if you want that program to start when only current user is logged 
Select to auto-start from: 



 Registry: Run – on every startup of Windows – this option will add startup 
setting to Windows registry, which is common place for auto startups. 
 Registry: RunOnce – only once on the next startup of Windows – this option is 
similar to previous one but will start the program only once and then that registry key will 
be deleted automatically by Windows . 
 Startup Folder – on every startup of Windows – this option will add a shortcut to 
the program in Startup folder, which is also common place for startups and accessible from 
Start menu -> All Programs 
  
 
There are more commands which you can execute over selected application:  

Run Process - run selected application 
Kill Process - stop selected application 
Search at Google for - use it to search with Google for the selected start up name, 
file name, publisher name or description. This command will open your default web 
browser and load the result of current search in the Google web site 
Open containing folder - opens a new instance of windows explorer and explore 
the directory, where the selected application is located 
Go to Location - opens "Registry Editor" and open the registry key with auto 
starting information of selected application 
Open Registry Key - opens "Registry Editor" and the registry key with the uninstall 
information of selected application 
Remove selected - remove selected application from the list 
Remove all not valid - remove all applications with status "not valid" from the list 
Remove all not running - remove all applications with status "not running" from 
the list 
Remove all disabled - remove all disabled applications from the list 
Properties - show application's properties 

 



 

5.2. Junk Files Cleaner 
 
Junk Files Cleaner allows you to find and remove various types of junk and unnecessary 
files from your computer. Many of the Windows applications create junk files. Normally, 
such files are deleted by the application that had created them as soon as it did not need 
them. However they may remain permanently on your hard drive if there is an unexpected 
termination of the parent application, a system crash, etc. If this happens, it will cause 
reduction of free disk space (even hundreds of megabytes) or may slow down system 
speed and performance 
 
With Junk Files Cleaner you can select which of your drives to scan and what extension of 
files to scan for. The most common temporary and junk files extensions are built-in, but you 
can also add whatever extension you want. 
 

 
 
Commands of Junk Files Cleaner 

Scan - to start scanning for junk files just press button "Scan" from the current 
toolbar or from Command menu. This action will perform a scan operation with your 
current options. A small window appears to wait until the scan is complete. There is a 



"Cancel" button on that window, if you press it the scan process will be interrupted and you 
will only see the junk files found until that moment. 

Delete - after the scan process is completed all found files are loaded in the list with 
their full path and name and their size. To delete any file of shown press "Delete" button 
and all check files will be deleted. 
 
There are more commands which you can execute over selected file(s): 

Open – open selected file 
Search at Google for – Use it to search with Google for the name of the selected file. 

This command will open your default web browser and load the result of current search in 
the Google web site 

 Open containing folder - Open a new instance of windows explorer and explore 
the directory, where the selected file is located. 

Properties – Show file’s properties 
Check all items – Set a check in front of all items in the list 
Uncheck all items –Remove the check in front of all items in the list 
Check all selected items - Set a check in front of all selected items in the list 
Uncheck all selected items - Remove the check in front of all selected items in the 

list 
 
You can adjust settings on Junk Files Cleaner by pressing “Options” button in the toolbar or 
from the Tools menu. 
 

5.3. Windows Tools 
 
There are a lot of handy and useful tools and components bundled with every Windows 
operating system. Some of them are with complex command line options, others are 
difficult to access. Windows tools give you a fast - one click - access to more than ten tools 
of Windows, which you use in your daily work. Almost all of them are included in Windows 
XP, Windows Vista and Windows 7. 
System Restore 
 
System Restore is a component of Windows operating system that you can use to restore 
your computer to a previous state, if a problem occurs, without losing your personal data 
files (such as Microsoft Word documents, browsing history, drawings, favorites, or e-mail). 
System Restore monitors changes to the system and some application files, and it 
automatically creates easily identified restore points. These restore points allow you to 
revert the system to a previous time. They are created daily and at the time of significant 
system events (such as when an application or driver is installed). You can also create and 
name your own restore points at any time. 
 
Network Diagnostics 
 
Network Diagnostics is a component of Windows operating system that you can use to 
gather and display information about your computer hardware and operating system, your 



internet configuration, and your modem and network adapter configuration. With the 
Network Diagnostics tool, you can perform a scan of your system and test network 
connectivity and whether or not your network-related programs and services are 
functional. It gathers a variety of basic information about the computer system which can 
be helpful when given to a support person trying to help you troubleshoot your system 
 

 
 
Network Information 
 
Network Information use a component of Windows operating system that you can use to 
display all current TCP/IP network configuration values and refresh Dynamic Host 
Configuration Protocol (DHCP) and Domain Name System (DNS) settings, Displays the full 
TCP/IP configuration for all adapters including IP address, MAC address, subnet mask, 
default gateway, Windows Internet Naming Service (WINS) and DNS configuration. 
Adapters can represent physical interfaces, such as installed network adapters, or logical 
interfaces, such as dial-up connections. 
 
Security Center 
 
Security Center is a component of Windows operating system that you can use to check the 
status of your computer for the three security essentials - Firewall, Virus protection 
software and Automatic Update. If a problem is detected with any of the three essentials 
(for example, if your antivirus program is out of date), the Security Center sends you an 
alert and provides recommendations for how to better protect your computer 
 
System Properties 
 
System Properties is a component of Windows operating system that you can use to do the 
following: 
 
    * View basic information such as your CPU type and RAM memory. 



    * View and change settings that control how your computer uses memory and finds 
certain information. 
    * Find information about hardware and device properties, as well as configure hardware 
profiles. 
    * View information about your network connection and logon profile. 
    * Report system and program errors to Microsoft or your system administrator when 
they occur. 
 
 
 
System Information 
 
System Information is a component of Windows operating system that collects and 
displays system configuration information for local and remote computers. This includes 
information about hardware configurations, computer components, and software, 
including signed drivers and unsigned drivers. System Information is a support tool that 
you can use to quickly locate information about your computer and its operating system 
 
TCP/IP Netstat Command 
 
TTCP/IP Netstat Command is a component of Windows operating system that displays all 
active TCP connections and the TCP and UDP ports on which the computer is listening and 
displays the executable involved in creating each connection or listening port. In this case 
the executable name is in [ ] at the bottom, on top is the component it called, and so forth 
until TCP/IP was reached. With simple words this command shows which applications are 
connected and on which port to the Internet and which are listening for incoming 
connections. 
 
On-Screen Keyboard 
 
On-Screen Keyboard is a component of Windows operating system that displays a virtual 
keyboard on the screen and allows users with mobility impairments to type data using a 
pointing device or joystick. On-Screen Keyboard is intended to provide a minimum level of 
functionality for users with mobility impairments. You also can use On-Screen Keyboard if 
you think that there is a Key-Logger installed on your PC and all the keys you typed are 
recorded. On-Screen Keyboard eliminates the possibility of recording typed keys. 
 
Disk Defragmenter 
 
Disk Defragmenter is a component of Windows operating system that analyzes local 
volumes and consolidates fragmented files and folders so that each occupies a single, 
contiguous space on the volume. As a result, your system can access files and folders and 
save new ones more efficiently. By consolidating your files and folders, Disk Defragmenter 
also consolidates a volume's free space, making it less likely that new files will be 
fragmented. The process of consolidating fragmented files and folders is called 



defragmentation. After defragmentation your hard disk drive will be well-arranged and 
your system will work faster and with ease. 
 
Services 
 
A service is an application type that runs in the background. Service applications typically 
provide features such as client/server applications, Web servers, database servers, and 
other server-based applications to users, both locally and across the network. Services is a 
component of Windows operating system that you can use to: 
 
    * Start, stop, pause, resume, or disable a service on remote and local computers. You must 
have the appropriate permission to start, stop, pause, restart, and disable services. 
    * Manage services on local and remote computers. 
    * Set up recovery actions to take place if a service fails, for example, restarting the service 
automatically or restarting the. 
    * Enable or disable services for a particular hardware profile. 
    * View the status and description of each service. 
 
 
 
Shared Folders 
 
Shared Folders is a component of Windows operating system that you can use to manage 
shared resources over a network, control user access permissions, session activity, shared 
resource properties and to view a summary of connections and resource use for local and 
remote computers. With Shared Folders, you can: 
 
    * Create, view, and set permissions for shared resources. 
    * View a list of all users who are connected over a network to the computer, and 
disconnect one or all of them. 
    * View a list of files that have been opened by remote users, and close one or all of the 
open files. 
 
 
 
Group Policy 
 
Group Policy is a component of Windows operating system that includes policy settings for 
User Configuration, which affect users, and for Computer Configuration, which affect 
computers. Group Policy settings define the various components of the user's desktop 
environment that a system administrator needs to manage, for example, the programs that 
are available to users, the programs that appear on the user's desktop, and options for the 
Start menu. To create a specific desktop configuration for a particular group of users, use 
the Group Policy snap-in. 
 
Add/Remove Windows Components 



 
Add/Remove Windows Components helps you to manage installed Windows components 
on your computer. After Windows OS is installed on your computer, you can use the 
Add/Remove Windows Components to add a Windows component that was not included in 
the original installation, or to remove an existing Windows component that you no longer 
require. 
 
Microsoft Windows Malicious Software Removal Tool 
 
The Microsoft Windows Malicious Software Removal Tool checks computers running a 
Windows operating system for infections by specific, prevalent malicious software and 
helps remove any infection this is found. This malicious software includes viruses, worms 
and Trojan horses. When the detection and removal process is complete, the tool displays a 
report describing the outcome, including, if any malicious software was detected and 
removed. 
 

5.4. Browsers Cleaner 
 
Your browser makes a detailed record of every web site you've ever visited. It's easily 
accessible from your browser window and simply by pressing a button anyone can see 
where you've been browsing on the web! Revo Uninstaller Pro erases web site history of 
web browsers including Internet Explorer, Netscape and Opera. With Browsers Cleaner 
you can also delete temporary internet files which are all the pictures you've seen, all the 
online videos you've watched and all the web pages you've visited. Deleting Temporary 
Internet Files will free a lot of space on your hard disk. 

 



Depending on the history setting you want to cleanup and the browser you have, you have 
to put check marks on these options and press Clear toolbar button or Clear command on 
the Commands menu. 
 

5.5. Microsoft Office Cleaner 
 

 
 

MS Office Cleaner allows you to remove history of most recently used files in MS Word, 
Excel, Access, PowerPoint and Front Page. If you do not want somebody else to see your 
last opened or edited spreadsheets, documents or other files created using MS Office just 
select those you do not want others to see and click the "Clear" button. Your most recently 
used files will no longer be listed. Windows also keeps a record of your recent files. Use MS 
Windows Cleaner included in included in Revo Uninstaller Pro to clear them too. 
 
MS Office Cleaner includes the following options to clarify most recently used files of: 
 
     Microsoft Excel 2000, XP, 2003 and 2007 
     Microsoft Word 2000, XP, 2003 and 2007 
     Microsoft PowerPoint 2000, XP, 2003 and 2007 
     Microsoft FrontPage 2000, XP, 2003 and 2007 
     Microsoft Access 2000, XP, 2003 and 2007 
 
Depending on the program, which history settings you want to cleanup you have to put a 
check mark on it and then press Clear toolbar button or Clear command on the Commands 
menu. 
 



5.6. Windows Cleaner 
 

 
 
Microsoft Windows keeps tracks of many things that you do with your computer like file 
search history when you search for file and folders; recently opened document history; 
open/save history used in standard open/save dialogs from different applications installed 
on your computer; start menu clicks history; last opened registry key history and more. 
Windows Cleaner allows you to remove all this history and temporary files. It's a useful tool 
because you can remove all this history from one place quickly and easily. You can also 
empty your Recycle Bin and delete temporary files which will free more disk space. 
 
Available options of Windows Cleaner are: 
 
     Clear Recent Documents History 
     Clear Start Menu Run History 
     Clear Find File History 
     Clear Printers, Computers and People Find History 
     Empty Clipboard 
     Clear “MS Paint” Recent Files History 
     Clear “MS WordPad” Recent Files History 



     Clear “Regedit” Last Opened Key History 
     Clear Common Dialog Open Save Recent History 
     Clear Common Dialog Last Visited Folder History 
     Empty Recycle Bin 
     Delete Windows Temporary Files 
     Delete Start Menu Click Logs 
     Delete crash memory dump files 
     Delete Chkdsk (Check Disk) recovered file fragments 
 
Depending on the history item you want to cleanup you have to put a check mark on that 
option and press Clear button on the toolbar or Clear command on the Commands menu. 
 

5.7. Evidence Remover 
 

 
 
Deleting your files and folders does not mean that they are gone forever. When you empty 
Windows Recycle Bin your files and folders are just marked as deleted but they are not 
erased physically. There is a chance to recover deleted data from 10 years or older PC and 
this data may be very important and confidential. With any recovery tool or un-delete 
program you can easily get back your important documents and other files that you have 



deleted. And here comes the Evidence Remove tool of Revo Uninstaller Pro. Evidence 
Remover will eliminate all chances to get data back from your hard drive. It will erase 
forever files and folders, which are already, have been deleted but left physically on your 
hard disk. No matter what tool you or somebody else will use to recover the data, including 
professional and expensive recovery and un-delete tools, the result will be always one and 
the same - the data erased with Evidence Remover is impossible to recover! 
 
To erase already delete files and folders you have to put a check mark in front of the drive 
where these files are deleted from. Then you have to press Execute toolbar button or 
Execute command from the Commands menu.  
 
The process is slow because the data is overwritten 3 times randomly! The speed depends 
on: 

- Computer Processor (CPU) 
- The size of the selected drive 
- Running programs 
- Running security software – anti-virus, Internet Security, etc. 

 
During the process, the free disk space decreases because Evidence Remover creates a very 
huge file and writes random data in it. That huge file is deleted at the end of the process – 
the free disk space is restored. 
 

5.8. Unrecoverable Delete 
 

 



 
If you want to securely delete a file or folder and to be sure that nobody with any tool could 
be able to recover this file or folder then use Unrecoverable Delete. Deleting files and 
emptying Windows Recycle Bin does not mean that these files are gone forever. They are 
still on your Hard Disk Drive or other storage but marked as deleted. Anybody, with a tool 
available free or commercial, could recover deleted data very easily. Unrecoverable Delete 
tool of Revo Uninstaller Pro makes this impossible, even if you try to do that with the most 
advanced and expensive tool on the market. Deleting files in Windows means that they are 
marked as deleted and the space they allocated is free to use. This is because if Windows 
has to physically erase all deleted files it will take time and will slow down your computer. 
Beside this there is a lot of system, temporary and other files which are not so important to 
be unrecoverable. Unrecoverable Delete physically erases all the files and folders and that's 
why it takes more time than simple deleting. 
 
Unrecoverable Delete has the following commands: 

- Add File(s) – using this command you can add files for unrecoverable delete 
from different folders and disk drives.  

- Add Folder – using this command you can add a folder for unrecoverable delete. 
All sub folders and files will be deleted permanently. 

- Delete Forever – executes permanent erasing of the added files and folders. You 
can cancel the process but erased files till the cancel will be unrecoverable, so 
please carefully select the files and folder you want to delete! 

 

6. Options 
 

 
 



6.1. General 
 
Here you can find some general options of Revo Uninstaller Pro like: 
 Current Language: - drop down box, which you can use to change the localization 
of Revo Uninstaller Pro. Note that it set when you install Revo Uninstaller Pro to the 
language you choose on install. 
 Backup Folder: - the folder, where all backups will be stored. You can change the 
place if the drive of the backup folder has no more free space.  
 Check for update on startup – Revo Uninstaller Pro will check if there is a new 
version available by connecting to www.revouninstaller.com on startup, but only once a 
day! No personal information is sent or received. Note that you have to allow Revo 
Uninstaller Pro to connect to the Internet in your firewall settings. 
 Skip information messages – if you do not want to see information messages from 
Revo Uninstaller Pro enable this option. Information messages are messages like “Revo 
Uninstaller Pro finished scanning for leftovers”.  
 Skip warning messages – if you do not want to see warning messages from Revo 
Uninstaller Pro enable this option. Warning messages are messages like “Are you sure you 
want to remove selected item?”. 
 

6.2. Uninstaller 
6.2.1. General 

 
Here are the main options affecting the whole uninstaller: 
 Set focus on Traced Programs on startup – when Revo Uninstaller Pro is started 
All Programs tab is shown by default; instead you can show Traced Programs by enabling 
this option 
 Make a System Restore Point and full registry backup before uninstalling – If 
Windows System Restore is enabled Revo Uninstaller Pro requests from it creation of a 
system restore point and makes full registry backup, which you can restore from Windows 
Recovery Console 
 Backup deleted Registry items – this option will cause all manipulations on 
Windows Registry to be backed up! The backups can be restored from Backup Manager. 
 Delete files and folders: 
This option shows where all deleted files are going: 

- to Backup folder – all deleted files are backed up. This option should not be 
used often because all programs uninstalled by Revo Uninstaller Pro will be 
moved to the backup folder and that will not decrease the free disk space as it is 
expected. You should go to Backup Manager to restore the files or to delete them 
if you really do not need them anymore. 

- to Recycle Bin – this option is similar to the previous one except that the files 
are moved into Recycle Bin. We recommend that option because it is safe and if 
you want to restore some files you just have to open the Recycle Bin. When you 
empty your Recycle Bin you will get additional free disk space. 

http://www.revouninstaller.com/


- Permanently – all deleted files and folders are deleted permanently, so you 
can’t restore them later. This is the fastest delete option  

Show as new programs installed: 
This option causes Revo Uninstaller Pro to show new programs in a separated group New 
Programs. New programs are always shown at the top of the list of programs. 
  - Last (in days) – you can specify how many days a program is considered as 
a new program.  
  - Since the last startup of the uninstaller – if a program is shown as a new 
program the next time you open Revo Uninstaller Pro that program will not be new 
anymore because it is shown as a new once and it is considered that the user has seen that.  
 

6.2.2. Groups Manager 
 
Groups Manager shows all available groups both for “All Programs” and “Traced 
Programs”. The groups order is important because that order is considered during the 
listing of programs – first group at the top of the list is shown first, second is shown second 
and so on. There are buttons, which you can use to move up and down (Move Up and Move 
Down) a group and change their order. There are also other buttons: 

- Add – used to add a new group by entering its name 
- Rename – used to rename a listed group by selecting it first 
- Remove – used to remove a group by selecting it first 
- Reset Defaults – removes all created groups and sets the default groups of Revo 

Uninstaller Pro, which are Internet, Games, Multimedia and Utilities 
 

6.3. All Programs 
Options here are related to the All Programs tab in the Uninstaller.  
 

6.3.1. General 
- Show system updates (not supported in Windows Vista and Windows 7) – 

the option shows Windows updates on Windows XP 
- Show system components – some programs have additional components 

which are removable but marked as a component of another program and by 
default Revo Uninstaller Pro does not list that kind of programs.  
 

6.3.2. Registry 
 
When a program from All Programs tab is uninstalled Revo Uninstaller Pro shows the 
leftover registry items and some of the items we know for sure that are not created by the 
uninstalled program. So, we have an exclude list for these items. You are also able to add or 
remove such items (using Add and Remove buttons) or Reset Defaults – remove all added 
and restore all removed items. 
 



A registry key could be excluded only by adding the full path to the key for example: 
HKEY_LOCAL_MACHINE\SOFTWARE\Classes 

 
There is an option for each registry key called Include Subkeys, which can be check 
marked. That option will exclude all sub keys of that registry key – not only the key itself.  
 
In front of each registry key there is a check box, which is used to enable or disable 
(depending if it is check marked or not) the exclusion of a registry key. If there is a check 
mark then the key is considered as excluded. 
 
Exclude list supports wild cards as (?) and (*), which means you can exclude several keys at 
once or without knowing the exact name of that particular registry key. For example: 

 HKEY_LOCAL_MACHINE\SOFT????\Classes 
This will exclude all registry keys in HKEY_LOCAL_MACHINE beginning with SOFT and 
have 4 characters following SOFT word, because (?) sign mean any character! 
   

HKEY_LOCAL_MACHINE\SOFT*\Classes 
This will exclude all registry keys in HKEY_LOCAL_MACHINE beginning with SOFT word 
and no matter how they end – any length, any characters after the SOFT word. You can use 
(*) char to replace the whole key name as: 

HKEY_LOCAL_MACHINE\*\Classes 
But this also will exclude the whole branch like: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
HKEY_LOCAL_MACHINE\HARDWARE\Classes 
HKEY_LOCAL_MACHINE\Microsoft\Classes 
HKEY_LOCAL_MACHINE\Your Company\Classes 
HKEY_LOCAL_MACHINE\Anything goes here\Classes 
 

You can also use a combination of (?) and (*).  
 

6.4. Traced Programs 
6.4.1. General 

 
Revo Uninstaller Pro creates log files when a program is installed through Revo Uninstaller 
Pro. The files are saved to a default folder, which can be changed if there is such need (not 
enough disk space). 

- Trace programs in compact mode – the option shows a small window on top 
of other windows when a program is installed through Revo Uninstaller Pro – 
has a Stop button and Recording animation. This option is not enabled by default 
and that is why Revo Uninstall shows a big band at the top of the screen when a 
program is installed through Revo Uninstaller Pro. 

 

6.4.2. Registry 



 
When a program form Traced Programs tab is uninstalled Revo Uninstaller Pro shows the 
leftover registry items and some of the items we know for sure that are not created by the 
uninstalled program. So, we have an exclude list for these items. You are also able to add or 
remove such items (using Add and Remove buttons) or Reset Defaults – remove all added 
and restore all removed items. 
 
A registry key could be excluded only by adding the full path to the key for example: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
There is an option for each registry key called Include Subkeys, which can be check 
marked. That option will exclude all sub keys of that registry key – not only the key itself.  
 
In front of each registry key there is a check box, which is used to enable or disable 
(depending if it is check marked or not) the exclusion of a registry key. If there is a check 
mark then the key is considered as excluded. 
 
Exclude list supports wild cards as (?) and (*), which means you can exclude several keys at 
once or without knowing the exact name of that particular registry key. For example: 

 HKEY_LOCAL_MACHINE\SOFT????\Classes 
This will exclude all registry keys in HKEY_LOCAL_MACHINE beginning with SOFT and 
have 4 characters following SOFT word, because (?) sign mean any character! 
   

HKEY_LOCAL_MACHINE\SOFT*\Classes 
This will exclude all registry keys in HKEY_LOCAL_MACHINE beginning with SOFT word 
and no matter how they end – any length, any characters after the SOFT word. You can use 
(*) char to replace the whole key name as: 

HKEY_LOCAL_MACHINE\*\Classes 
But this also will exclude the whole branch like: 

HKEY_LOCAL_MACHINE\SOFTWARE\Classes 
HKEY_LOCAL_MACHINE\HARDWARE\Classes 
HKEY_LOCAL_MACHINE\Microsoft\Classes 
HKEY_LOCAL_MACHINE\Your Company\Classes 
HKEY_LOCAL_MACHINE\Anything goes here\Classes 
 

You can also use a combination of (?) and (*).  
 

6.4.3. Processes 
 
When a program is installed through Revo Uninstaller Pro some of the processes should 
always be included and logged. You can add processes to be included in the monitoring 
using Add button and specify full path to the process. You can also Remove added 
processes or just uncheck mark them, which will remove them from consideration as 
included. Reset Defaults button will remove all added processes and add default ones. 
 



Exclude Processes works in the same way as Include Processes except that processes in 
its list are not monitored during the installation of programs. 
 
 

6.5. Junk Files Cleaner 
 

Delete files to the Recycle Bin - if the option is check marked then all junk files are 
moved to the Recycle Bin. This can be considered as additional safety but will not increase 
the free disk space till you empty your Recycle Bin 

 
Ignore files accessed last 24 hours - this option is enabled by default because some 

junk and temporary files are in use during the scan for junk files and it is better to leave 
them. 
 

General Options - There is a list with all logical drives on your hard drive. If there is a 
check mark before the drive name, this drive will be scanned for unnecessary files when 
the scan operation is performing. If there is no check mark, the drive will be skipped.  

 
There is a list with patterns (mostly file types) and their description where you can select 
which pattern to scan for when scan operation is performing. Files matching with a given 
pattern will be shown in the result list only if there is a check mark before the pattern. If 
you remove a check mark, the pattern after it will not be taking into consideration while 
scanning is being done. 

 
Also you can add or remove patterns from the list by using underneath buttons. To add 
new pattern press button “Add” and a small window will appear where you can type 
desired pattern using wild cards (?,*) and press “OK” to add it to the list or “Cancel” to 
ignore operation. 
 
To remove a pattern, select it in the list and press “Remove” button. If you want to restore 
the default built-in patterns, just press “Set Default” button and all your patterns will be 
deleted and default will be set 

 
Exclude Options - If you wish to exclude any files contained within any directory from 

a scan, there is a list with patterns of paths on the local drives, where you can select which 
pattern to be scanned when scan operation is performing. Directories matching with a 
given pattern will be skipped in the scan process only if there is a check mark before the 
pattern. If you remove a check mark, the pattern after it will be scanned for unnecessary 
files. 

 
Also you can add or remove patterns from the list by using underneath buttons. To add 
new pattern press button “Add” and a small window will appear where you can type 
desired pattern using wild cards (?,*)  and press “OK” to add it to the list or “Cancel” to 
ignore operation. 



 
To remove a pattern, select it in the list and press “Remove” button. If you want to restore 
the default built-in patterns, just press “Set Default” button and all your patterns will be 
deleted and default will be set 
 

6.6. View 
Revo Uninstaller Pro has Themes support and they can be changed here. There is a drop 
down box where you can choose from several Visual themes. You can also set if the 
toolbars should have text labels and if the icons of the toolbars should be small. 
 

7. Registration and Activation 
 
Revo Uninstaller Pro has 30 days free trial period. You can use it during that period without 
any restriction! When the free trial period is over, you can continue using it by entering a 
Registration Key, which you can get by purchasing a License from our web site – 
www.revouninstaller.com 

 
To enter your Registration Key you have to: 

1. Go to Help menu 
2. Choose Registration… 

 
Enter the received Registration Key, which you will receive after purchase of Revo 
Uninstaller Pro, in your e-mail, and press Activate Online button! 
 
The activation requires an Internet connection because Revo Uninstaller Pro should 
activate and validate your License by checking our server – www.revouninstaller.com 
We respect your privacy so no personal info is gathered, sent or received! 
 
If your computer does not have an Internet connection, please contact us at 
support@revouninstaller.com . Please, include details of your purchase, like full name, 
address, order id, e-mail and License Key received from us! 
 

8. Command Line support 
 
Revo Uninstaller Pro supports command line options and has command processor 
RevoCmd.exe  
 
RevoCmd.exe can be used to list installed programs on a computer. It could be used to list 
programs by a part of the name. It could also show the install location and the uninstall 
command of the program which could be then used to start the built-in uninstaller of the 
program. 
 
Usage:  
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RevoCmd /m "program name" [/i] [/u] [/p] 
      /m - Match program name using wildcard characters - * and ? 
              The asterisk (*) wildcard represents any collection of characters 
               The question mark (?) wildcard represents any single character 

            Example: RevoCmd /m Microso* 
              Shows all programs beginning with the name Microso 
      /i - Include Install Location if exists 

    /u - Include Uninstall command 
      /p - Pause on each page 
      /? or /help - This help 
 
 

9. Restore Full Registry Backup 
 
Revo Uninstaller Pro creates full registry backup once each day it has been started! It 
creates a full registry backup on each program uninstall by default and that could be 
disabled from its options. It also creates backup of registry items removed during 
uninstalls.  
 
Full registry backups should be used only if Backup Manager cannot restore 
removed items or Windows does not start properly anymore! 

Option 1: Starting the Windows Recovery Console from the Windows CD-ROM 

If you have not preinstalled the Windows Recovery Console, you can start the computer 

and use the Recovery Console directly from your original Windows installation disc. If your 

computer is already in Windows and you want to add the Windows Recovery Console as a 

startup option, go to the next section "Adding the Windows Recovery Console as a startup 

option." 

1. Insert the Windows CD into your CD drive and restart your computer. If you are 
prompted, select any options required to start (boot) from the CD. 

2. When the text-based part of Setup begins, follow the prompts. Select the repair or 
recover option by pressing R. 

3. If you have a dual-boot or multiboot system, select the installation that you want to 
access from the Recovery Console. 

4. When you are prompted, type the Administrator password. 

Option 2: Adding the Windows Recovery Console as a startup option 

If your computer starts Windows, you can add the Windows Recovery Console as a startup 

option from the Windows environment. To install the Recovery Console as a startup option, 

follow these steps: 



1. With Windows running, insert the Windows CD into your CD drive. 
2. Click Start and click Run. 
3. Type the following commands (where X: is the CD Drive letter), and then press 

ENTER on your keyboard. 

X:\i386\winnt32.exe /cmdcons 

Note There is a space before /cmdcons. 

4. Click OK and follow the instructions to finish Setup. 

Note This adds the Windows Recovery Console to the Windows Startup folder. 

5. Restart your computer and select the Recovery Console option from the list of 
available operating systems. 

Option 3: If you have already installed the Recovery Console 

If you have already installed the Recovery Console, you can select it during your usual 

Windows Startup. To run the Recovery Console: 

1. During Startup, select Recovery Console from the startup options menu. 
2. If you have a dual-boot or multiboot system, select the installation that you want to 

access from the Recovery Console. 
3. When you are prompted, type the Administrator password. 
4. At the command prompt, type Recovery Console commands, and then you can refer 

to the commands that are listed in the "Available commands within Windows 
Recovery Console" section. 

* Select your Windows installation.  
* Type the administrator password. Press enter if you don't have one. 
 
      Enter the following commands: 
      (Assuming you have installed Windows on “Local Disk (C :)”) 
       
Step 1:   CD “C:\Documents and Settings”  
(The above command contains quotation marks and you should type them also) 
 
Step 2:  DIR 
(A list with folder names will show up, you will see your user name – remember it for the 
next step) 
 
Step 3:  CD “XXX\Local Settings\Application Data\VS Revo Group\Revo 
Uninstaller Pro\RegBackup\Daily\” 
 



(You should replace XXX with the user name you saw in the previous step, the above 
command contains quotation marks and you should type them also) 
 
OR 
 
Step 3:  CD “XXX\Local Settings\Application Data\VS Revo Group\Revo 
Uninstaller Pro\RegBackup\Last\” 
 
There are two folders with Full Registry Backup! First folder is named Daily because it is 
created once a day – once each day when Revo Uninstaller Pro is started! Second full 
registry backup is created on each uninstall of a program. If you are sure that you want to 
restore full registry backup created before uninstalling of a program then use second 
option for Step 3 – Last.  
 
For example in the following scenario: 

1. Run  Revo Uninstaller Pro for the first time for that day – Daily full registry 
backup is created 

2. Uninstall a program – Last full registry backup is created 
3. Uninstall second program – Last full registry backup is overwritten 
4. Uninstall third program – Last full registry backup is overwritten 

 
The Daily backup will revert all changes as no program has been uninstalled. The Last 
backup will revert only the last changes made by uninstalling the last program. 
 
Step 4:  BATCH Restore.dat 
 
Press ENTER after each step! 
 
Step 5:  Remove any Windows CD/DVD and restart your PC 
       
 


